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New College Web Site Offers New Online Services
After a year of planning and restructuring, designing and
coding, Lake Forest College has a new web site
(www.lfc.edu). The result of hundreds of hours of work, the
new site is designed to serve the needs of campus users as
well as the thousands of visitors that access Lake Forest College information.
The new Lake Forest College pages boast a host of new features, most noticeable of which is the strong visual appearance of the site. Each month, a new home page graphic will
highlight a different aspect of the beauty of our campus. Less
frequently, the interior graphics will also change to add variety to the second level of the site.
One popular service implemented with the new web site is
the Online Directory (accessible via the title bar on the top
The new home page boasts a new online directory, improved design
of every page) containing contact information for students,
and
interface for easy navigation, and information on campus events.
faculty, staff, and participating alumni. Much like the annual paper directory in its format, the Online Directory has
the advantage in that it can accommodate changes and additions all year round (please let us know if you notice information that needs
updating). Faculty members can look up student email addresses, box numbers, and home information. For privacy reasons, requests
from outside the College will receive only a student’s email address, graduation year, and web address (if applicable). (see Web, page 2)
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It’s most likely that we will experience some
inconveniences due to the Y2K bug, but they
probably aren’t going to be so serious that
you should start converting all of your assets into Krugerrands and begin making
plans to move into a cave in the hills.

Y2K

By now you are probably well aware of the
origin of the Y2K problem. A seemingly insignificant computer programming convention in which software was written to accept
only two digits as day, month, and year indicators (i.e. dd/mm/yy), has turned out to
be, in fact, quite significant. When calendars roll over to 01/01/00, some computers
and microprocessors will have difficulty
determining what to make of a year ending
with the digits “00.” Is it 2000 or 1900? No
one really knows for sure how our lives will
be affected next January.

Lake Forest College has been working on
its Year 2000 plans for over eighteen months.
Our key administrative system, the system
that keeps track of such things as registration, grades, student billing, and payroll, is
a newly-developed system that is fully Y2K
compliant. Our new library system, DRA,
is also compliant. In addition, all hardware
and software purchased by LIT within the
last two years (with the possible exception
of Windows 95, compliant with some “mi(see Y2K, page 6)
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Web (cont’d from page 1)
The new web pages contain a number of details to help visitors
access campus information. At the bottom of every page we have
added a drop-down menu listing all of the
main areas of the site. To jump from one
area (for instance, “Academics”) to another (“News and Events”), click on the
desired location in the drop-down menu.
We have also added a title bar at the top
of all pages that indicate the area of the
site currently accessed. This bar also contains links to our College search page, directories, contact page, and home page.
News and Events is another new area of the site, maintained by the
Office of Marketing and Communications (OMC). Online versions
of LFC publications like the Spectrum and Spector are now available from this area.

Natural and Mathematical Sciences Marylin Bell (5114)

We have also expanded the Community area of the site, providing
information on local restaurants, movie theaters, and cultural opportunities in the Lake Forest area as well as in Chicago.

Contacts for Specific Services

Work is now beginning on a new campus tour, which will include
video clips, 360-degree panoramas of the campus, and supplementary information. Suggestions for this project are welcome.

Archives and Special Collections
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Audio Visual Services

Mary Moss (5058)

Book Acquisitions
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Linda Mathiesen (6220)
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Interlibrary Loan

Susan Cloud (5062)

LFBBS

Diane Snedden (5113)

Periodicals

Rita Koller (5065)

Reference Desk

5074

Software Licensing

Diane Snedden (5113)

Switchboard & Computer Supplies

Jan LePak (5120)

Telecommunications

Linda Mathiesen (6220)

Web Authoring

Valerie Archambeau (5116)
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The updated web site represents a 14 month effort with various
committees working on the new design, organization, and policies
for the new site. Student web assistants provided invaluable service, working with the design and assisting a number of departments in creating and updating pages.
The Web Committee views the unveiling of the new site as Phase 1
of the implementation. In Phase 2, programs will be developed to
ensure the ongoing vitality of the site. LIT intends to set up a number of services to keep the information on the web fresh and dynamic. Part of this entails tailoring a level of support that fits the
needs of individual departments and offices.
LIT is seeking a Web Contact in each department to help coordinate the maintenance of that department’s site. We are also planning a series of workshops to assist our contacts in the creation
and upkeep of their pages.
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TechTips
More ILLINET Online Tips

1.

Renewing a Book

2.

Books can easily be renewed online.
1.
2.

Click the Options menu and select Borrower Information.
From the next menu, select Items Checked Out.

3.
4.

In the ID line, type the 14 digit barcode number.
In the PIN line, type the last 4 digits of your social security
number.
From the list, select the number of the book you want to
renew and press Enter.
Type Y for yes, when asked if you’d like to renew the book,
then press Enter.
The new due date will be reflected in the Items Checked
Out list.

5.
6.
7.

Checking Borrower Information
In addition to renewing items, Borrower Information allows access to other information.
1.
2.
3.

To see if you have accrued any fines, click on the Options
menu, select Borrower Information, and then select Fines.
The Requests option in Borrower Information displays
any book requests that you have recently placed.
Finally, the Change Pin option allows you to change your
Pin number to something other than the last 4 digits of your
social security number.

Things To Remember About Ordering Books
•
•
•

In order to request books from other libraries, you must log
in with your Library ID number (14 digit barcode number).
If you log in as Guest, you will not be given the choice to
request a book from another Library.
It is not necessary to specify a school – the system will select the school.

3.
4.

5.
6.
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At the next screen, type your email address at the Email
Address prompt and press Enter.
The records will be emailed immediately, and you will receive no further notification.

Voicemail Shortcuts
Using Express Messaging
The Express Messaging service allows you to access a person’s
voicemail box directly.
1.
2.

Dial 6246 (on campus) or 735-6246 (off campus).
When asked, enter the extension (“mailbox”) of the person
for whom you are leaving a message.
3. Press the number sign (#).
4. Leave your message, then hang up.
You can only leave messages for one person at a time using Express Messaging.

Forwarding a Message in Voicemail
1.
2.
3.

4.

Emailing Records
You can send item records to yourself through email:

From the results list, select Mark Citations from the Options menu.
In the box, type the numbers of the books that you want to
email then press Enter.
Select Citation Manager from the Options menu, and then
select Procedures.
From the next menu, select Mail Records.

5.

Access the message you wish to forward.
Dial 73.
Enter the extension of the person or persons for whom you
are forwarding the message. If you are forwarding to more
than one person, separate the extensions with the number
sign (#); end the list with an additional number sign.
If you wish, press 5 to leave a brief message explaining the
nature of the mail you are forwarding; press the number
sign when you are finished recording.
To send the message, dial 79. (If you change your mind and
wish to cancel, dial 76.)
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TechTips
Computing Tips
Using Mathematical Expressions in MS Word
Would you like to put a mathematical expression into a word-processing document? With Office 97 (PC) or Office 98 (Mac) you
can embed various types of information from Office Tools, a set of
helper applications. In this example, we will be inserting an equation, but clip art, graphs, or organizational charts may also be inserted with other Office Tools. To use the Office Tools:
1.
2.
3.
4.

5.
6.

In your active document, place the insertion point where
you would like your object to appear.
Click on the Insert menu, then select Object. This makes
the “Object Selection List” window appear.
Click on the Create New tab.
Select Microsoft Equation from the list in your window,
and click OK. Microsoft’s Equation Editor toolbar appears
with various equation buttons. A box with handles will also
appear. This will be the working area that is “embedded”
into your document.
Enter your equation by clicking on the appropriate buttons
on the equation toolbar and using numeric keys.
Exit the “editing mode” of Microsoft Equation by clicking
anywhere outside the embedded equation window. The
handles of the box will disappear, indicating that you have
exited Microsoft Equation.

Note that when you move your mouse pointer over the embedded
object, crosshatch arrows appear. If you click on the object, the
handles reappear and the object can be moved. If you wish to further edit your equation, you must double click over the object to
activate your Equation Editor Tools.

Take Control in MS Office
Tools: Options: Spelling and Grammar Menu
Do you get annoyed by the red and green squiggly lines Word
places underneath your words? You can customize how the Spell
Check works. To change the Spell and Grammar Check options,
click on the
Tools menu,
then select
Options
(Windows) or
Preferences
(Mac). Click
the Spelling
& Grammar
tab. Check
and uncheck
boxes to turn off and on features such as “Check spelling/grammar as you type.” You can also ask the spell check to ignore
words in UPPERCASE and Internet addresses.
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Tools: Options: Save Menu
The Save tab in the Options Window (or Preferences window for
Mac) allows you to specify AutoRecovery and other save features.
LIT recommends unchecking the “Allow fast saves” option, since
Fast Saves can occasionally cause file corruption.
LIT recommends that you activate “AutoRecovery” for every 510 minutes. The AutoRecovery saves a temporary file, in the event
of a power failure or crash.
Typically, when the AutoRecover feature is turned on, Word automatically opens any recovered documents when you restart Word
after a power failure or similar problem. However, if Word did not
automatically open the recovery file, you can manually open it.
By default, the file is located in the Temp folder, which in turn, is
in the Windows folder. Please note:
•

•

AutoRecover is not a replacement for regularly saving your
documents, because the recovery file is deleted when you
save or close a document.
When Word automatically opens a recovery file, the recovered file is deleted if you choose not to save the file.

Tool: Options: Compatibility
To use this feature, follow these steps:
1.
2.

3.

Click on the Tools menu, and select Options (Windows) or
Preferences (Mac), then click the Compatibility tab.
In the “Recommended Options For” box, click the file format of the file you are working with. Select Custom to
specify individual options.
In the Options box, select the options you want.

Note: Changing the options affects only the display of a document
while you’re working with it in Word. It does not permanently
change any formatting in the document.

Is Your Word Software Too Bossy?
Customize the pesky AutoCorrect feature! Click on the Tools menu
and select AutoCorrect. You will find four tabs of options available:
AutoCorrect,
AutoFormat As
You
Type,
AutoText, and
Auto Format.
If Word is putting capital letters where you do not need them, click
on␣ the AutoCorrect tab, then turn off features such as “Capitalize
the first letter of sentences.” Do you dislike the way Word inserts
numbers (or bullets) in front of your lists? Click on the AutoFormat
As You Type tab and deselect “Automatic numbered (bulleted) lists.”
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LIT EVENTS Fond Adieus and Bienvenu
Library Workshops
Check–in at the Reference Desk.
ILLINET Online (Book Searching)
Monday March 8, 3:00–4:00PM
Databases for the Humanities
Tuesday March 16, 3:00–4:00PM
Databases for the Social Sciences
Thursday March 18, 10:00–11:00AM
Databases for the Sciences
Wednesday March 24, 10:00–11:00AM

IT Seminars
Watch your email for more information on these upcoming computing
workshops:
Intro to Windows 95
Thursday March 4, 2:00–4:00PM
Intro to Mac
Friday March 5, 2:00–4:30PM
Searching the Web
Monday March 8, 10:00–11:00AM
Netscape Mail
Thursday March 11, 10:30–12:00PM
Web Page Design (HTML)
Friday March 12, 2:00–4:30PM

We in the Office of Library and Information Technology are accustomed to dealing
with rapid change. This semester, those
skills will come in handy as two valued staff
members leave us to take on new challenges. They will be missed, and those of
us remaining, with the help of new staff,
will strive to fill the void they have left.
On February 26th, the Lake Forest College
Library reluctantly but fondly bid adieu to
Vanaja Menon, Associate College Librarian. Vanaja has accepted a position as Assistant Director for Public Services at the
University of Wisconsin-Milwaukee.

Her many long years of dedicated service
began in 1986 as an acquisitions and technical services assistant. While working fulltime, she completed her Master’s Degree
in Library Science at the University of Chicago in 1989, and was subsequently promoted to Assistant Librarian. She has served
as the Associate College Librarian since
1992. Her dedication to service and, most
especially, her valued role as a colleague
and friend will be greatly missed.
Upon Vanaja’s departure, Melinda Dermody
assumes the position of Head of Public Services. Melinda will continue as a Reference Librarian while coordinating the
Library’s Circulation, Interlibrary Loan, and
Reference services.
In a development which has caused a considerable reassignment of professional re-

Making Window 95 Work for You
Thursday March 18, 10:00–11:30AM
Using Microsoft Word
Friday March 19, 2:00–4:30PM
Intro to Excel
Tuesday March 23, 2:00–4:30PM
FTP Basics: Publishing Web Pages
Thursday March 25, 2:00–3:00PM
Website Maintenance
Thursday April 1, 2:00–3:30PM
Desktop Maintenance
Thursday April 8, 2:00–3:30PM
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Welcome, Cory!

Vanaja and Gene (not pictured) will be missed.

sources, Gene Shin’s last day as Network
Administrator was December 31st, 1998.
Nick Ritter and David Levinson now coordinate campus network services.
David also remains responsible for library
computing as Systems Librarian. John
Brandt, in addition to managing Government Documents, is moving downstairs in
the Library to take over supervision of the
Library’s Technical Services. Corinne
(Cory) Stevens completes this round of
musical chairs by joining the Library staff,
taking over John’s Reference duties upstairs.
Cory begins her appointment as a Reference Librarian on March 8th, 1999. Cory
received her Bachelor’s degree from Pace
University in New York, and her Master of
Library Science degree from the University
of Texas-Austin. For the last five years, she
has served as a Catalog Librarian at Williams College in Williams, Massachusetts.
In addition to providing reference service,
Cory will lend her considerable experience and expertise to the Library’s cataloging efforts.
In other professional development news,
Library Serials Supervisor Rita Koller received her Master of Library Science degree from Dominican University in
January. While working full-time managing all of the Library’s periodical acquisitions and processing, Rita has earned
both her Bachelor’s and Master’s degrees,
taking one or two courses at a time. We are
very proud of her hard work and commendable accomplishments.
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What’s New in Library and Information Technology
Trend of Full Text Databases
Although there are notable exceptions, the
majority of Library index resources are now
available as electronic databases. The current trend for these databases is to provide
the full text of the entire article rather than
a simple citation. Of the 60 plus databases
available at Lake Forest College, over a
dozen provide full text articles.
In addition to being very convenient and
useful for Library users, full text databases
enhance the Library’s collection in a variety of ways. One of the main benefits of
full text databases is that they expand the
Library’s periodical collection. An article
that LFC does not own would normally be
ordered through Interlibrary Loan. However, if that article is available in a full text
database, it is instantly accessible. The Library has compiled a list of the journals
available in full text databases at:
www.lib.lfc.edu/fulltext/index.html
Additionally, many journals are now being
published in both print and electronic format. For instance, Diacritics, an academic
journal on literary criticism, is available in
an online version through Project Muse (described below). Also, numerous resources
that were formerly available only in print,
such as some key government documents,
can now be found online.

While useful for a variety of reasons, this
full text trend also raises some concerns for
Libraries. Students often confuse these databases, for which the Library pays a large
subscription fee, with the free resources
found on the web. Most of this confusion is
caused by the fact that although the
Library’s “for-charge” databases are available through the web, these databases are
accessible only to LFC users. Many students
mistakenly see the Library’s databases and
the web as one in the same.
The main problem with this misunderstanding is that the resources available through
the Library’s full text and other databases
are much more reliable sources of information than many web pages, which can literally be published by anyone. Evaluation
skills are essential in selecting resources on
the web, while using resources from Library
databases eliminates some of the evaluative
guesswork involved in research.
Another concern is that once students learn
about full text databases, they often will use a
full text database whether or not it is the best
source for their research. Many of the full text
databases are “general topic” in nature, which
is appropriate for some research. However,
some in-depth research requires more comprehensive subject-specific databases (examples: PsycInfo and MLA) and many
students are unwilling to use any subject-spe-

Y2K is On Its Way, (cont’d from page 1)
nor issues”) is also compliant. Some older
software being used by individuals may
have to be upgraded or replaced. We do
have Y2K compliant versions of all software programs supported by LIT, and will
be recommending that those faculty and
staff presently using older software update
over the coming months.
At present we are in the process of testing
the BIOS (Basic Input Output System) on
College-owned PCs to identify and resolve
potential Y2K problems. We know that
some PCs have BIOS programs that will
interpret January 1, 2000 as January 1,
1900. The first time these computers are
powered up after January 1, 2000, DOS
or Windows will attempt to rectify the date
discrepancy by resetting the date to January 4, 1980, the earliest date the computer
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can recognize. This scenario has the potential to create conflicts with date sensitive software. As we encounter potential
BIOS problems, we will correct them either through a software patch, BIOS upgrade, or in some cases, replacement of
the machine.
A task force is coordinating a campus wide
Y2K effort that is in the process of identifying all of the key vendors and systems
used by the various campus departments.
All vendors will be contacted and asked
to provide assurance that their business is
Y2K compliant. This is being done to
minimize any potential disruption in the
provision of mission-critical goods and
services to the College and to ensure that
the campus environment remains safe and
comfortable for all of us.

cific database if it is not full text. Physically
locating an article in the Library is much less
convenient than printing the article from the
computer, but the added effort is rewarded
with better, relevant resources.
Finally, with students’ easy access to complete, downloadable articles, plagiarism is a
concern for many professors. LFC Librarians
are available to assist professors in determining whether or not a paper has been copied
from a full text databases or the web. Librarians also welcome the opportunity to
provide Library research instruction sessions
if professors find that their students’ sources
are inadequate, or leaning too heavily on full
text, web, or other non-book sources.

Project Muse
The Library has recently purchased a subscription to Project Muse, a service providing web-based access to over 40 journals

These journals are just a few of the
many available from Project Muse.
published by Johns Hopkins University
Press. Most of the journals, which cover the
Humanities, Social Sciences, and Mathematics, begin coverage around 1996. The
full text of these articles includes all illustrations, tables of contents, bibliographies,
citations, and endnotes. Keyword and boolean searches are available for all of the journals in the database. Project Muse is
accessible from any campus-networked
computer. To access Project Muse, go to:
www.lib.lfc.edu/muse/

Office Hours for Faculty
Diane Snedden will hold office hours Monday, Wednesday, and Friday from 12:001:00 p.m. to help faculty and staff struggling
with new technology. Drop by her office in
Johnson room 175B and she will assist you.
You can also set up an appointment by calling x5113. Scanning and color printing will
also be available.

LIT BIBLIOFILES

